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1. INTRODUCTION

1.

INTRODUCTION

Thank you for buying the K-Junior Smart Evo (abbreviated KJ-EVO in this document)!

With this card, you will be able to create many new embeddednsygsby interfacing
standard devices or enhance the K-Junior V2 robot by expanding its computing power.

1.1 How to use this handbook
This handbook introduces the KJ-EVO and its various operating modesq&ickastart,
jump to chapter: 4Usage.

If this handbook does not answer one of the problems you wish to solves pteesult
the K-Team web siteh{tp://www.k-team.comand especially the Forum and the FAQs.

. Unpacking and Inspection : KJ-EVO package description and first use

. Description : KJ-EVO description
. Usage . KJ-EVO usage descriptions.
. Annexes . Detailed descriptions of several helpful tools and

commands are explained.
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1. INTRODUCTION

1.2  Safety precautions

Here are some recommendations on how to correctly use the KJ-EVO:

» Keep the board away from wet area Contact with water could cause malfunction
and/or breakdown.

e Store your board in a stable position This will avoid the risks of falling, which
could break it or cause damage to a person.

* Do not plug any connectors while the board is powered oo avoid any damage,
make all connections when the board power is off.

* Never leave the KJ-EVO powered when it is unused When you have finished
working with KJ-EVO, turn it off. It will save the battery life.

1.3 Recycling

Think about the end of life of your product! Parts of the board can peledcand it is
important to do so. By recycling you can help to create a cleamtesafer environment for
generations to come. For those reasons please take care ¢oytleng of your product at
the end of its life cycle, for instance sending back the produbetmanufacturer or to your
local dealer.

Thanks for your contribution to a cleaner environment!
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1. INTRODUCTION

1.4 Specifications

The main specifications of the KJ-EVO card are listed below:

* Processor . OMAP 3503 ARM Cortex-A8 CPU @ 600MHz
 Performance : Upto 1200 Dhrystone MIPS
*  Memory : 512 MB RAM
512 MB Flash
* Features
= USB host

= Micro SD Connector

= Mini USB OTG connector for USB slave
= 1°C

= Serial port

=  Wifi B/G, Bluetooth v2.0 + EDR

= 3-axis accelerometer

= Sound: 2 speakers and microphones
= 2PWM

= 2GPIO

= 2ADC

= Color camera 752x480, 30 fps

« OS : Linux OS, Angstrom distribution (OpenEmbedded tools),
kernel 2.6.34
 Power
consumption : 410mA @5V
» Size : 105 width x 125 depth x 110 height* [mm]
* Mass : 110g¢g

* with antennas, without lower pins
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2. UNPACKING AND INSPECTION

2.  UNPACKING AND INSPECTION

2.1 Package Contents

Figure 2-1: Contents of the KJ-EVO Pack

Your package should contain the following items:

1. KJ-EVO board
2. DVD with software and this User Manual

KJ-EVO User Manual rev 1.0



2. UNPACKING AND INSPECTION

2.2 Inspection

The KJ-EVO board basic functions should be tested after unpackingn#pl€te Linux
system is installed in the KJ-EVO flash memory. The systan be started as a standalone
Linux box, with the initial console displayed on the serial line &wakk connection (Bluetooth,
Wifi, USB). No application is started except some standard daeamzhthe initial shell on the
console.

The Bluetooth port should be linked to a terminal, suchiascom, on the host computer. The
basic configuration for the serial line should be (see chapter 4.3 "Power-Up"):

- 115200 Bps

- 8 data bits

- No parity

- 2 stop bits

Then when switching power on of the K-Junior robot, the Linux login mesdameéd be
displayed on the terminal (see chapter 4.3). If no charactereweec the Bluetooth connection
and terminal settings should be checked. The boot can be accésadserial cable and level
shifter adapter (see chapter 5;1.1). If the boot is interrupted at gomig especially during
kernel uncompress step, then the system is probably corrupted. Chapter 4gp®&ding the
kernel and the file systeindescribes how to upload a new system to the board. If the boot
process is completed to the login prompt, then the boot messages shoh&tked for errors,
please refer to chapter 3.3XJ-EVO Softwaré for further information on the KJ-EVO Linux
system.
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3. Description

3. Description

3.1 Overview

An overview of the KJ-EVO hardware is depicted in the Figure 3.13ghdl'he locations of
various key elements are indicated for later references.

All the connectors are described in the subsequent part of this chapter.

Antennas for Wifi and Bluetooth

/ Slave USBpo\A

User connector

Host USB port

Wifi, Power, and
Bluetooth leds (resp.

USD connector

Figure 3-1: KJ-EVO overview — top view
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3. Description

Connectors to the robo

Figure 3-2: KJ-EVO overview — bottom view
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3. Description

3.2 KJ-EVO Hardware

The hardware of the KJ-EVO is described in the sub-chapters thereafter.

3.2.1 User connector

The KJ-EVO user connector provides signals for several inesxfadl input-output are in
the range of 0-5 V. There are 1 serial, 1 i2c, 2 PWM, 2 GPIO, 2 AY, @xd 2 ground pins as
described in figure 3.3 below. For specific usage, see source code examples on chapter 4.5.2.1.

For using a standard RS232 cable, you should use a level shifter foctiogie the serial TX
and RX pins.

1 GND 2 GND

3 VCC audio* 1 2 4 VCC audio*
5VCC 6 VCC

5 PWM1 8 PWMO

9 AD1 10 ADO

11 GP1 12 GPO

13 RX 14 TX

15 SCL 16 SCA

Figure 3-3: User connector and pins descriptions

*voltage of the battery (3.7-4.2 V): for the old K-Junior ( revision A) coming from KJ-
EVO battery; for the new K-Junior (revision B), coming from the robot battery

3.2.2 Reset
The KJ-EVO reset can be triggered by pressing the reset budter{gure3-1). When
pressing the reset button, the board core and the robot are reset.

3.2.3 USB Host

The KJ-EVO provides two different USB interfaces. One is the PXA270 USB device
interface and the other one is a complete USB Host interface. The USB Hdatefmovides a
way to connect USB devices to the KJ-EVO, such as webcams or external disksadeheras
designed specially for an USB memory stick.
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3. Description

The connected USB memory stick will be mounted autonomouslimedia/sdal For
removing it, execute commairnnount/media/sdaland finally unplug the stick.
3.2.4 -SD connector

With the p-SD connector and a p-SD card, you can easily trdite$eto and from the KJ-
EVO.

Power off the KJ-EVO; insert the uSD card; power on the KJ-EVO.
Typing mount shows the mounted card location:

/devimmcblkOp1 on /media/mmcblkOpl type vfat ...
=> You can copy files to and from the card at the location /media/mmcblkOp1

3.25 Leds
There are 3 leds indicating the power status (green for ON), thed&uvork connection
and the Bluetooth connection, both blue for connection (see Rglixe
3.2.6 USB slave
With the USB slave connector of type mini-B, you can plug an USB cable to a computer
and control the console of the KJ-EVO board. See chapter 5.1.4 for usage.
3.2.7 Microphones

There are 2 microphones for recording ambient sound. See chapter for 5.1.8 usage.

3.2.8 Speakers

There are 2 speakers for playing stereo sound. See chapter 5.1.8 for usage.

3.2.9 Camera
There is a color camera integrated to the board. Its resolution is 752x480 pixed® and ¢
take images up to 60 fps. See chapter 5.1.6 for usage.
3.2.10 Connectors to the robot

There are 3 groups of pins holes to be connected to the robot. See figure 3.4; chapter 4.2
and K-Junior user's manual for usage.
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Figure 3-4: robot connectors of the KJ-EVO (bottom view)

3.2.11 Wifi and Bluetooth

The Wifi G and Bluetooth connections are available. See chapter 4.3 for Bluetooth and
chapter 5.1;2 for Wifi.
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3. Description

3.3 KJ-EVO Software

A KJ-EVO embedded system is based on two main software componasts tBe Linux
Operating System kernel, and the second is a set of softveamieages that is called a
distribution.

The KJ-EVO uses the Linux distribution called "Angstréom OpenEmbedded".

The Linux kernel is based on standard Linux kernel sources, withtadiden made by
Gumstix. Further, exhaustive, information about Linux kernel is ddaillom many sources,
especially on the web, starting frduttp://www.kernel.org The installed distribution is based on
the handhelds familiar distribution, which is specially designecefobedded systems. Please
visit the "Angstrom" websitlttp://www.angstrom-distribution.oydor further information about
this project. The main components within this distribution are desciibettie following
sections.

Using the KJ-EVO, Linux system should be pretty straightforviardisers with a Linux
or Unix background considering that all components are standard.

In the next chapter.4Jsage
", the installation and usage of the KJ-EVO software is de=tribnd in the Annexes,
tools for customizing, configuring and using specific tools are detailed.
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4. Usage

4, Usage

4.1 Required hardware / software
The required hardware and software to use the board and develognpsaare described
below.

4.1.1 Required hardware

e Computer with Bluetooth or USB port with Linux or Linux emulation* (not
included)

* K-Junior robot (version V2) with its USB cable

4.1.2 Required software

Required free space:
N 3 GB on/ust/local (for light toolchain)

. 15 MB on user account (~/)

Required files:

. Linux OS* (kernel 2.6.x) on the computer with the following packages

installed:
= gcc . GNU C compiler
= minicom : terminal emulation
= Irzsz . communication package

= Cross-compiler light . kjunior-oetools-1.0-light-kb1.tar.bz2
= Environment script . env.sh

» Board library sources : kj-evo_library_1.0.tar.bz2

= K-Junior slave firmware . kjOS_Slave B-01.hex

Remarks: you may find updated version of these software at:
http:/ftp.k-team.com/K-JuniorV2/extensions/kj-evo/software

*With a virtual machine, you can also use the toolchain. See chaptér 5.1.9.
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4. Usage

4.2 Assembly

The assembly of the board with the robot is depicted in Figuitelnsert the 3 groups of

[ I . 1

pins of the KJ-EVO into the 3 connectors of the robot. Deploy the 2 antennas.

Antennas

KJ-EVO's pins

Figure 4-1: Basic assembly
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4. Usage

4.3 Power-up and console access

You can have console access through different ways (serial port: chapter 5.1.1, USB
chapter 5.1,4, Wifi: chapter 5.1.2). The following explanation will be for the Bluetooth:

1) Install the Linux packagézsz containing communications programs. If your Linux
distribution is Ubuntu:
sudo apt-get install Irzsz

2) On the Linux computer, run the emulation terminal Minicom:
sudo minicom
If Minicom is not installed you have to install this package. Haux Distribution
“Ubuntu”, the command is:

sudo apt-get install minicom

Install blueman , a Bluetooth manager for Linux:

sudo apt-get install blueman

3) Change the firmware version of your K-Junior v2 robot. The robot needs to
reflashed in slave mode with the special firmwki@S_ Slave B-01.hexSee theK-
Junior V2 User's Manual, chapter 5.1 entitled-Junior Uploader for uploading that
file.

You can find a normal version of the firmware if you want to revert it at:
http://ftp.k-team.com/K-JuniorV2/Software/Firmware/

4) After having assembled the KJ-EVO board to the K-Junior robop{ehd.2), switch
the robot on.

5) Go to the Bluetooth configuration of your computer and search fowaleeice (with
blueman. The KJ-EVO board will appear a§J-EVO-ABCD, where ABCD is the
serial number (Don't connect K6-Junior EFGH, which is the robot itself). Pair the
robot with the access ke9@000 (four zeros). Withblueman right click on the paired
KJ-EVO-ABCD, choose Connect to: Serial Pott

6) Run minicom with the commandudominicom -o

7) Set its parameters with the sub-menu “Serial port setup” ofméreu [configuration]
(keys Ctrl-a + 0) as described;in Figure.4Push RETURN key to validate each time.
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A - Serial Device : /dev/rfcommo
B - Lockfile Location : /var/lock

C - Callin Program :

D - Callout Program :

E - Bps/Par/Bits : 115200 8N1

F - Hardware Flow Control : No

G - Software Flow Control : No

Change which setting?

Figure 4-2: Minicom serial parameters

8) Save the settings with the commar@hVe setup as . of the menu [configuration] (cf
Figure 4-3) and choodaduetooth You will be able to run again the program and load

this configuration withsudominicom —o bluetooth

+----- [configuration]------ +
Filenames and paths |
File transfer protocols |
Serial port setup |
Modem and dialing |
Screen and keyboard |
Save setup as dfl |
Save setup as.. |
Exit |

Figure 4-3: Minicom configuration menu

9) Push RETURN key and the prompt of the KJ-EVO board will be availéfibure

4-4):

The Angstrom Distribution kj-evo rfcomm@

Angstrom 2010.7-test-20110202 kj-evo rfcommO

KJ-EVO User Manual rev 1.0
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4. Usage

kj-evo login:

Figure 4-4: KJ-EVO prompt

10)Login to the KJ-EVO with the following parameters:
Login:  root

Password: (none, press “Return” key)

=> You are at the prompt of the Linux console of the KJ-EVO (see Figure 4-5).

kj-evo login: root
Password:

root@kj-evo:~$

Figure 4-5: KJ-EVO prompt: logged

11)In the directoryexamples(~/example$, you will have the library examples compiled.
You can execute each by preceding its name With

cd examples

Jadc_example

You can add a password:to the login of your KJ-EVO board with the compaasd/d
You can upload or upload a file with the KJ-EVO at chapters 5.1.1.2 and 5.1.1.3 .

Continue with next chapter 4.5 for starting programming.
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4. Usage

4.4 Shutdown / Reboot / Reset

Shutdown:

While logged into the console of the KJ-EVO, it is better to gooper shutdown than just
switching off the K-Junior robot. This will ensure that the open filies correctly closed and
settings saved.

1) Run the following command in the console:

shutdown —h now

2) Wait 15s (if you are logged through the serial cable, you wait Gystem halted
appears). Then you can switch off the robot.

Reboot:
If you want to reboot, you can use:

shutdown —r now

Reset :

The KJ-EVO reset can be triggered by pressing the reset budter{gure3-1). When
pressing the reset button, the board core and the robot are reset.

You may need the reset while the software is blocked and you cacocexds anymore by
another connection withsh (see chapter 5.1.5) for killing the annoying process or doirajta s
reboot.
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4. Usage

45 Software

The following sub-chapters explain the software installation and application
development with the board.

Two development packages are available:

* Light toolchain
* Full toolchain and sources: for advanced users; kernel modificatiorksgessc
creation/addition

In the subsequent paragraphs, only the light tool chain is explaifed.full toolchain is
described in the following chapter 4.6.3. With a virtual machine, yolwalsanuse the toolchain
from another operating system (see chapter.5.1.9).

4.5.1 Installation of light toolchain

The installation of the software required to use the board and theopenezit tool is
described in the next sub-chapters.

Below are listed the files needed to install the light toaichBhese files are available in
the DVD or from the Internet urhttp://ftp.k-team.com/K-JuniorV?2/extensions/kj-evo/software/

Fromlight_toolchain/folder:

= Light toolchain (cross-compiler only):
kjunior-oetools-1.0-light-kb1.0.tar.bz2 *

Fromcommon_filesfolder:

= Environment script:  env.sh

Fromlibrary/ folder:
= Board library sources:kj-evo_library 1.0.tar.bz2 *

* where 1.0 is the release version (may change

without notice)
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45.1.1 Installation of the development directory

The development directory will be the base folder for your developrtiesdntains links
and scripts to easily use the cross-compiler to make your programs.

1) Create a new development foldelkj-evo_developmenin your home directory and
enter into it. You can use the following commands, assuming you are in a console.

mkdir ~/kj-evo_development

cd ~/kj-evo_development

2) Obtain the environment script fiEenv.shfrom the folder above and put it in your new
development directory/kj-evo_development

3) If you gave any other name or path to the development forlder yohavd to modify
the KTEAM_HOME variable in the fileenv.sh to point to your development
directory:

Default:
KTEAM_HOME=~/kj-evo_development

To be modified to:
KTEAM_HOME=FULL_PATH_OF YOUR_NEW_DEV_FOLDER
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4. Usage

4.5.1.2 Installation of the cross-compiler (lightt  oolchain)

1) Extract the cross compil&unior-oetools-1.0-light-kb1.0.tar.bzth /usr/local with the
command:

sudo tar -xjf kjunior-oetools-1.0-light-kb1.0.tar.bz2 -C /usr/local

Remarks:  You must be root or usgdo You must put the tools there because there
are hardcoded links.

2) You can check if the installation is correct by running the ccosspiler. Firstly make
the environment variables available then check the version of the cross-compiler

cd ~/kj-evo_development
source env.sh
arm-angstrom-linux-gnueabi-gcc --version

=> The last command should return:
arm-angstrom-linux-gnueabi-gcc (GCC) 4.3.3

4.5.1.3 Installation of the board library

The library is already installed on the KJ-EVO. To instad tibrary on your development
system, follow the following instructions:

1) Extract the librarkj-evo_library 1.0.tar.bz2n your development folder:

tar -xjf kj-evo_library 1.0.tar.bz2 -C ~/kj-evo_development

2) You can recompile the whole library by running the following commands$e kj-
evo_library folder:

cd ~/kj-evo_development/kj-evo_library
source ../env.sh (if not already sourced in this console before)
make clean

make

3) If you modified the library (any file irsrc/), you will have to transfer the filbuild-
overo/lib/libkj-evo-1.0.sdo your KJ-EVO board, overwritin@isr/lib/libkj-evo.so.
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The board library contains these files and directories:

build-overo/ compiled library and headers
doc/ documentation (API: start in
doc/html/index.htm)}

examples/ source code examples of programs
adc_example.c adc and accelerometer examples
camera_example.c camera example
gpio_example.c Digital input/ouput (GPIO) example
gripper_example.c K-Junior gripper example
i2c_example.c i2c usage example

kjunior_and_gripper_example.c K-Junior and gripper example

kjunior_example.c K-Junior example
pwm_example.c PWM example
sound_example.c Microphones/Speakers example
src/ source code of the library
template/ template program
Makefile Makefile for all
README.kteam readme file

You can find an updated version of the library from the following ftp site:
http://ftp.k-team.com/K-JuniorV2/extensions/kj-evo/software/library/

KJ-EVO User Manual rev 1.0
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4.5.2 Programming and light toolchain usage

45.2.1 Application development

A template progranprog-template.cis available in the board library in the foldiir
evo_library/template

You can start your code into the template program and use the fgl@emmands to
build it. The first one makes the environment variables (path to ties-compiler, libraries)
available to the system and the second run Madefile script to compile and build the

executable program. Enter in tkpevo_librarytemplatefolder and type in a console to build
the template program:

cd ~/kj-evo_development/kj-evo_library/template
source ~/kj-evo_development/env.sh

make

=> The ‘template” file is the executable output file.
You can transfer the program to the KJ-EVO by Bluetooth or Wifi (see ch&piePsand 5.1:3).
Then execute it on the board by running:

Jtemplate

Application Programming Interface documentation of the library is dleik:
~/kj-evo_development/kj-evo_library/doc/html/index.html

Remarks:
If you modify the program name, you will have to modify its occumsnin the
Makefile file.

You can find many examples of source code/kj-evo_development/kj-evo_library/examples

(see list end of 4.5.1.3).They are compiled with the command below. To compile only the
examples, run:

make clean_examples

make kj-evo_examples

See next sub-chapter for using Eclipse guide for editing source code.

See chapter 5.1.10 for debugging your program.
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45.2.2 C/C++ Programming: using GUI source code ed itor Eclipse

You can use also Eclipse as source code editor. See instructionshioglaw install and
use it.

Install the Java Runtime Environment (JRE) if not already installed.

4)

5)

6)

7)

8)

9)

Find the version corresponding to your OS here:
http://www.eclipse.org/downloads/moreinfo/jre.php

Download the linux version of "Eclipse IDE for C/C++ Developenmsl(ides Incubating
components)” from (for Ubuntu users, don't install with apt-get becahes apt-get
version is older):

http://www.eclipse.org/cdt/

Extract the Eclipse program file:
sudo tar -xzf eclipse-cpp-indigo-SR2-incubation-linux-gtk.tar.gz
You can also create a link to the start fledo In -s eclipse/eclipse /usr/bin/eclipse
You should have installed the latest version of the kj-evo toolchairt drghull). Copy

the debugger program filearm-angstrom-linux-gnueabi-gdbto /usr/local/kjunior-
oetools-1.0/tmp/cross/bian your computer.

You can check by opening a terminal and sourcing the kj-evo environntéritsaurce
env.sh” (chapter 4.5.2.1), command:

arm-angstrom-linux-gnueabi-gdb --version
which should return:GNU gdb (GDB) 7.1

Run eclipse and at the "Workspace launcher" window, choose where yod Meulo
put your project.

Go to file menu “File => C Project” (or C++; for running a Cen the kj-evo, you must
install the standard C++ library:

with the commandpkg install libstdc++6 4.3.3-r22.1.6_armv7a.ipgin the kj-evo)
and choose a Project Name (ex: test).

In the next window "C Project”, push the "Advanced Settings" battahon the “C/C++
Build => Discovery Options”,

for c: On 'GCC C Compiler chang€ompiler invocation command to
'flusr/local/kjunior-oetools-1.0/tmp/sysroots/i686-linux/usr/armv7a/bindaangstrom-
linux-gnueabi-gcc'

or (depending if your project is C or C++)

for c++: On 'GCC C++ Compiler' changéompiler invocation commaridto
'lusr/local/kjunior-oetools-1.0/tmp/sysroots/i686-linux/usr/armv7a/bindaangstrom-
linux-gnueabi-g++
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4. Usage

10) On C/C++ “Build => Settings”, “Cross GCC Compiler” change Cormmand to
'fusr/local/kjunior-oetools-1.0/tmp/sysroots/i686-linux/usr/armv7a/bindaangstrom-
linux-gnueabi-gcc

11)On “Cross GCC Compiler” Includes => Include paths, add:

/usr/local/kjunior-oetools-1.0/tmp/sysroots/i686-linux/usr/include

12) On Miscellaneous, replace "Other flags" witb “march=armv7a -mtune=xscale -Wa,-
mcpu=xscalé

13) On the Cross GCC Linker, chang€ommand to /usr/local/kjunior-oetools-
1.0/tmp/sysroots/i686-linux/usr/armv7a/bin/arm-angstrom-linux-gnueabiegc

14)On “Cross GCC Linker => Libraries” at "Libraries (-I), akidevo with the + button on
the upper right.

15) At "Libraries search path", addusr/local/kjunior-oetools-1.0/tmp/sysroots/armv7a-
angstrom-linux-gnueabi /lib

16) On "Cross GCC Assembler”, in Command field, modify fasr/local/kjunior-oetools-
1.0/tmp/sysroots/i686-linux/usr/armv7a/bin/arm-angstrom-linux-gnueabi-as

17) Choose “C/C++” Build menu at the left, “Discovery options” repbat steps above
from 7) for the Release configuration.

18) push “Finish” button.
19) Go to menu “File => New => Source file” chodsst.cas filename

20) Close the Welcome window with its cross at the upper left.
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21) Insert in thdest.cfile the following C source code:

#include <stdlib.h>
#include <stdio.h>
#include <kj evo/kj evo.h>

int main(int argc, char *argv[]) {
int rc;

// initialise kj-evo library
if((kj evo init( © , NULL )) < 0 )
fprintf(stderr,"Error: Unable to initialize the kj-evo

library!\r\n");
return -1;
}

printf("Library kj-evo Template Program\r\n");

22) Then cross-compile the project with menu “Menu Project => Build-All”
=> The output file will be in the subdirectory Debug or Release of the project.

23) Transfer the file "test" to your kj-evo (see chapter 4.5.2.3).

24) And execute the program file with commarftest

4.5.2.3 Transferring files

You can transfer files to and from-the . KJ-EVO hoard by different means. Thetaefaus
Bluetooth (see chapter 4.3). You have'also serial (chapter 5.1.1). But USB stguer(&hl.4)
is faster and Wifi the fastest way (chapter 5.1.3).
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4.6 Full toolchain and sources

The full toolchain is for advanced users who would like to modifykér@el, rebuild the
image system or develop new packages for the KJ-EVO.

Remarks: Prior knowledge of Linux, its kernel and Open Embedded tools is highly

recommended.

4.6.1 Required software

Required free space:

» 38 GB on/usr/local (51 GB including the packed tools)

15 MB on user account+{)

Required files:

. Linux packages

= g+t
» patch

= help2man
= (diffstat

= texi2html
= makeinfo

= ncurses-dev

" CVS

= gawk

= python-dev

» python-pysqlite2 :
= subversion

= git

= chrpath

GNU C++ compiler
patch software
manual converter

reads the output afiff and displays a
histogram

convert to html
produce doctéxinfo on Ubuntu)

library allowing the programmer to
write (ibncurses5-dewn Ubuntu)

revision control system

programming language designed for processing text-
based data

dynamic object-oriented programming language
Python sqgl interface

version control system

fast version control system

allows you to change the rpath (where the application
looks for libraries) in an application
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On Ubuntu Linux distribution, you can use the following command to install all the
above packages in one time:

sudo apt-get install g++ patch help2man diffstat texi2html texinfonidoirses5-dev
cvs gawk python-dev python-pysqlite2 subversion git-core chrpath

. Included in the DVD-ROM of the package:

= Cross-compiler and
“Open Embedded” tools sources  kjunior-oetools-1.0-kb1.0.tar.bz2 *

»= Environment script . env.sh
= Board library sources : kj-evo_library_1.0.tar.bz2 *

= Script and files for uploading kernel
and file system . flash, MLO, u-boot.img

* where 1.0 is the release version (may change without notice)

4.6.2 Installation

1) Install the development directory as explained in chapter 4.5Ihdtallation of the
development directofyif not already done.

2) Extract the cross compiler sourdganior-oetools-1.0-kb1.0.tar.bzih /usr/local with
the command:

sudo tar -xjf kjunior-oetools-1.0-kb1.0.tar.bz2 -C /usr/local

Remark: you must put the tools there because there are hdcoded links. You
have to overwrite the light tools if they were already installed.

3) You can check if the installation is correct by running the ccosspiler. Firstly make
the environment variables available then check the version of the cross-compiler

source ~/kj-evo_development/env.sh
arm-angstrom-linux-gnueabi-gcc -version
=> The last command should return:

arm-angstrom-linux-gnueabi-gcc (GCC) 4.3.3

4) Install the board library as explained in chapter 4.5.118stallation of the board
library’ .
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4.6.3 Full toolchain usage

4.6.3.1 Rebuilding the whole system

To rebuild the toolchain system, the image file and the kernetuexdhe following
instructions:

1) In a console in the directorysr/local/kjunior-oetools-1.Q source the following file to
have access to the environment setup:
source extras/profile

2) With the following commands you can rebuild the whole system:
o Cleaning : bitbake -c clean kj-evo-image

0 Rebuild : bitbake kj-evo-image

=> The output files will be stored in:
/usr/local/kjunior-oetools-1.0/tmp/deploy/glibc/images/overo

Three main files will then be built:
the kernel : ulmage-2.6.34-r97-overo.bin
its modules : modules-2.6.34-r97-overo.tgz
the file system:
Angstrom-kj-evo-image-glibc-ipk-2010.7-test-20110718-overo.rootfs.tar.bz2 *
* where 20110718 is the release version

Remarks:
You may find updated version of these software at:

http://ftp.k-team.com/K-JuniorV2/extensions/kj-evo

With the chapter-4-6:3.3Uploading -the-kernel and-the file- systémyou can upload
these files to the K3-EVC.

You can find more information abohitbake,the tool for executing task and managing

And information about the OEtools is available here:
* Cross-compiler and tools (OpenEmbedded):

LA AIERASAAARL 4 A 4RA AREL A A A LA 4B LAALALLEALL L LE] L

* Linux distribution of the KJ-EVOnttp://www.angstrom-distribution.arg

fbA L] ALEERASA AL L AL AL LA L AL AR

*  Gumstix documentationntip:/vwww.gumstix.org
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4.6.3.2 Kernel modification

You can modify the kernel here by accessing to its menu with these commands:

cd /usr/local/kjunior-oetools-1.0/tmp/work/overo-angstrom-linux-gnuedibiix-
omap3-2.6.34-r97/qgit/
and configure the kernel with:

make ARCH=arm menuconfig

copy ".config" file to/usr/local/kjunior-oetools-
1.0/user.collection/packages/linux/linux-omap3-2.6.34/overo/defconfaefconfig
is the new filename)

Then you rebuild it and the file system by executing these comnadritie root of thdJ-
EVO oetools:

cd /usr/local/kjunior-oetools-1.0

source build/profile

bitbake -c clean virtual/kernel
bitbake virtual/kernel (may take up to 30 min depending of your computer)

= The new kernelilmagefile will be located at:
/usr/local/kjunior-oetools-1.0/tmp/deploy/glibc/images/overo/ulmage-overo.bi
Build also thdilesystenmmage:

bitbake -c clean kj-evo-image

bitbake kj-evo-image

= The newfilesystenwill be located at:
/usr/local/kjunior-oetools-1.0/tmp/deploy/glibc/images/overo/kj-evo-image
overo.tar.bz2

You can now upload the files to the KJ-EVO with chapter 4.6.3ldading the
kernel and the file systefn
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4.6.3.3 Uploading the kernel and the file system

You may need to reflash your KJ-EVO board by uploading the kankfilesystem if you

want to upgrade or if something went wrong.

i [ E WARNING: All the data on the KJ-EVO will be lost after running the following

instructions!

Material needed:

« uSD card with uSD reader
« level shifter for serial port and modified serial cable (see chapter 5.1.1)
- flash, MLO andu-boot.imgscript from DVD or K-Team's ftp

1) Firstly you will need to make 2 partitions on your uSD card. Backluhe data on
your uSD card before.

Follow the chapters "Partitioning the Card", "Formatting the Neavtitions" and
"Installing the Boot Files" the instructions there:

http://www.gumstix.org/create-a-bootable-microsd-card:html

2) You will take the ulmage and Angstrom-kj-evo-image-glibc-ipk-2010.7-test-
20110718-overo.rootfs.tar.bz2

* where 20110718 is the release version
from K-Team ftp or from your full oetools directory (see chapter 4:6.3.2):

/usr/local/kjunior-oetools-1.0/tmp/deploy/glibc/images/overo/

3) Copy also thd&j-evo-image-overo.tar.bz&ndflash into youruSD in the first partition.

The names of the kernalmage and the filesystenkj-evo-image-overo.tar.bzghust
match with the ones in tHash file.

4) You will need a serial connection to the KJ-EVO (see chapter 5.1.1).
Insert the uSD created above and power-up your KJ-EVO.

5) Login and run the flash script with the commands:
cd /media/mmcblkOp1/flash

flash

6) Shutdown with the command :

shutdown —h now

7) Wait until System haltechppears, unplug the power or shutdown the K-Junior robot if
mounted and remove tSD card.
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4.6.4 Packages installations
With OpenEmbedded, you can easily cross-compile existing packagekl grour own.
You can list installed packages on the board with the comnopikd: list_installed
4.6.4.1 Existing packages

Many packages are available for Open-Embedded. Here beloweiastructions to add an
existing package:

1) Check if there is already a recipe package is alreadysiilocal/kjunior-oetools-
1.0/org.openembedded.dev/recipes

2) If it is present, you can compile it by running in thisr/local/kjunior-oetools-1.0
directory:

source extras/profile

bitbake PACKAGE_NAME

3) The package will be created in one of the folders into:
/usr/local/kjunio-oetools-1.0/tmp/deploy/glibc/ipk/

4) Transfer the package to the KJ-EVO (with Minicom or sske: deapter 5.1.1.2Tb
send a file to the KJ-EVO (uploa®r chapter 5.1.3Transferring files using scp).

5) Then install it:
opkg install PACKAGE_NAME.ipk

4.6.4.2 Removing packages

You can remove a package with the command:
opkg remove PACKAGE_NAME

You may have to add the command parameterce-dependsf the package depends on others.

4.6.4.3 Creating new package:

You can create new packages for the KJ-EVO, following the instructions there:
http://www.gumstix.org/software-development/open-embedded/160-bitbak&kition]

And if you installed the full toolchain, an example is availabte /usr/local/kjunior-oetools-
1.0/user.collection/recipes/helloworld
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5.

Annexes

5.1

Tools and commands

In this part, the detailed descriptions of several tools and helpful commands areezkpl

5.1.1 Using the serial port and Minicom

The User connector (chapter 3.2.1) has a serial port that can be used to coraict the
EVO board to a computer.

A\

1)

2)

3)

Warning:Pay attention to the Voltage 0-5V of the User connector. It is not the standard
RS232 voltage level! You will need a voltage level shifter.

Install the Linux packagézsz containing communications programs. If your Linux
distribution is Ubuntu:

sudo apt-get install Irzsz

On the Linux computer, run the emulation terminal Minicom:

minicom
If Minicom is not installed you have to install this package. Houx. Distribution
“Ubuntu”, the command is:

sudo apt-get install minicom

Set its parameters with the sub-menu “Serial port” setup ofmtireu [configuration]
(keys Ctrl-a + 0) as described. in Figard.

You may modify the serial port device name depending where yggegduyour serial
port (see chapter 5.1.Using the serial port andMinicom”).

If you use a serial to USB adapter, the serial device m&yevéityUSBO

A - Serial Device : /dev/ttySoO
B - Lockfile Location : /var/lock
C - Callin Program :

D - Callout Program :

E - Bps/Par/Bits : 115200 8N1
F - Hardware Flow Control : No

G - Software Flow Control : No

Change which setting?

Figure 5-1: Minicom serial parameters
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Save the settings with the commar8hVe setup as dfbf the menu [configuration] (cf
Figure 5-2).

+----- [configuration]------ +
Filenames and paths |
File transfer protocols |
Serial port setup |
Modem and dialing |
Screen and keyboard |
Save setup as dfl |
Save setup as.. |
Exit |

Figure 5-2: Minicom configuration menu

5.1.1.1 Establish the serial connection

Set its parameters with the sub-menu “Serial port™ setup-of'the menu [cotiigira
(Figure 5-4) accessed with keys “Ctrl-a + 0” as described in Figure 5-3.

You may modify the serial port device name depending where you plugged your serial
port. If you use a serial to USB adapter, the serial device may be /dev/lyUSB

A - Serial Device : /dev/ttySo
B - Lockfile Location : /var/lock
C - Callin Program :

D - Callout Program :

E - Bps/Par/Bits : 115200 8N1
F - Hardware Flow Control : No

G - Software Flow Control : No

Change which setting?

Figure 5-3: Minicom serial parameters

Save the settings with the sub-mei®ave setup as df(Figure 5-4).
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+----- [configuration]------ +
Filenames and paths
File transfer protocols
Serial port setup

Modem and dialing
Screen and keyboard
Save setup as dfl

Save setup as..

Exit

Figure 5-4: Minicom configuration menu

Instruments X-Loader 1.4.4ss (Oct 20 2010 - 10:10:28)
OMAP3503-GP ES3.1

Board revision: 0

Loading u-boot.bin from nand

U-Boot 2010.09 (Oct 20 2010 - 10:11:49)

OMAP3503-GP ES3.1, CPU-OPP2, L3-165MHz, Max CPU Clock 600 mHz
Gumstix Overo board + LPDDR/NAND

I2C: ready

DRAM: 256 MiB

NAND: 256 MiB

*** Warning - bad CRC or NAND, using default environment

NAND read: device 0 offset 0x280000, size 0x400000
4194304 bytes read: OK
## Booting kernel from Legacy Image at 82000000 ...
Image Name: Angstrom/2.6.34/overo
Image Type: ARM Linux Kernel Image (uncompressed)
Data Size: 3255012 Bytes = 3.1 MiB
Load Address: 80008000
Entry Point: 80008000
Verifying Checksum ... OK
Loading Kernel Image ... OK
0K

Starting kernel ...
Uncompressing Linux... done, booting the kernel.

Linux version 2.6.34 (jtharin@KHEPERAG4) (gcc version 4.3.3
(GCC) ) #1 Wed Jun 29 14:46:53 CEST 2011.
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The Angstrom Distribution kj-evo ttyS2

Angstrom 2010.7-test-20110202 kj-evo ttyS2

kj-evo login:

Figure 5-5: part of the KJ-EVO Boot log

5.1.1.2 To send a file to the KJ-EVO (upload)
1) In the Minicom console, hold the key&ttl + a” and press$’ and select “Z-Modem”.
2) Select the file you would like to upload to the KJ-EVO (navigath the arrows keys,
2x “spacebar to change directory andspacebar to select the file).
Select [Okay] to send it.

5.1.1.3 To send a file to the computer (download)
In the Minicom console at the prompt of the KJ-EVO, type the foligsgommand,
where FILENAME is the file you would like to send.

Isz FILENAME

=> The file FILENAME is sent to the last directory Minicom used (or ifefanged,
where it started).
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5.1.2 Using Wifi

There are different ways described below for configuring the Wifi nétvempending on
the given security.

You can transfer file with thecpcommand (see chapter 5.1.3). You can have remote access to
the KJ-EVO with chapter 5.1.5.

5.1.2.1  Without any encryption for security:

- Modify the file /etc/network/interfacesvith your wireless network settings:

YOUR_SSID_OF_NETWORK the SSID of your wireless network

YOUR_IP_ADDRESS the ip address you would like for the KJ-EVO
YOUR_NETMASK the netmask of your wireless network
YOUR_GATEWAY_IP the gateway of your wireless network

[FrrRxrixrixrkxxix [atc/network/interfaces file *x**xxkxrx/

auto wlan0O

#iface wlanO inet dhcp

iface wlanO inet static
wireless_mode managed
wireless_essi¥OUR_SSID OF NETWORK
addressyOUR_IP_ADDRESS
netmaskryOUR_NETMASK
gatewayY OUR_GATEWAY _IP

/**********************************************/

The 3 last following steps are optional but will get you Internet connection:
« delete the linketc/resolv.cont rm /etc/resolv.conf
« insert the local domain name/eic/resolv.conf
echo search YOUR_LOCAL_DOMAIN_NAME >>/etc/resolv.conf

- and the dns server

echo nameserver YOUR_DNS SERVER_IP_ADDRESS >>/etc/resolv.conf
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5.1.2.2 WEP encryption support

a) for configuring the wifi connection, type:
iwconfig wlan0 essid YOUR_SSID_OF_NETWORK
b) if the network is secured, enter the key by typing :
iwconfig wlan0 key YOUR_KEY
c) then set an ip address to the KJ-EVO:
ifconfig wlanO YOUR_IP_ADDRESS
d) configure the gateway by entering the gateway ip:
route add default gw YOUR_GATEWAY _IP wlan0
e) insert the local domain naméeetc/resolv.conf
echo search YOUR_LOCAL_DOMAIN_NAME >>etc/resolv.conf
f) and the dns server
echo nameserver YOUR_DNS_SERVER_IP_ADDRESS >>/etc/resolv.conf
You can also create a file ietc/network/if-pre-up.dnamed wireless to have these
settings saved.
Put the following into it:

#!/bin/sh

ifconfig wlanO up

iwconfig wlan0 essid YOUR_SSID_OF_NETWORK
iwconfig wlan0 key s:YOUR_KEY

ifconfig wlanO YOUR_IP_ADDRESS

route add default gw YOUR_GATEWAY _IP wlan0

And the following in a file nametétc/resolv.conf
search YOUR_LOCAL_DOMAIN_NAME

nameserver YOUR_DNS_SERVER_IP_ADDRESS

5.1.2.3 WEP, WPA and other encryptions:

a) Create a file namedtc/wpa_supplicant/wpa_supplicant.conf
and insert your selected wireless encryption:
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WEP:
#Shared WEP key connection (no WPA):
network={
ssid="YOUR_SSID"
key _mgmt=NONE
wep_keyO="YOUR_WEP_KEY"
auth_alg=SHARED
wep_tx_keyidx=0
priority=5
}
WPA-TKIP:

#/etc/wpa_supplicant/wpa_supplicant.conf

#with WPA-PSK TKIT:

network={
ssid="YOUR_SSID"
psk="YOUR_PASS_KEY"
key _mgmt=WPA-PSK
group=TKIP
pairwise=TKIP
proto=WPA
priority=5

}

You can check the following link for other encryptions:

b) run the daemon controlling the wireless connection with the following command:
wpa_supplicant -c /etc/wpa_supplicant/wpa_supplicant.conf -i wlanO -Dwext -B
c) In/etc/network/if-pre-up.chamed wireless, add the following commands:

#!/bin/sh

ifconfig wlanO up

ifconfig wlanO YOUR_IP_ADDRESS

route add default gw YOUR_GATEWAY wlan0

wpa_supplicant -c /etc/wpa_supplicant/wpa_supplicant.conf -i wlanO -Dwext -B

d) reboot the system or restart the network with the following command:
/etc/init.d/networking restart
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5.1.3 Transferring files using scp (ssh)

1) Establish a network connection between the computer and the KJ-EMér, with
Wifi or with USB slave.
2) Execute the following command:
scp FILE root@KJ-EVO_IP:/home/root
where FILE . is the file to transfer,

KJ-EVO_IP : isthe KJ-EVO ip address.
Push the Return key when a password is asked.

5.1.4 Networking over USB slave

Connect an USB cable to the mini USB slave port of the KJ-EVO board (chapter 3y2.6). B
default the KJ-EVO USB slave port is configured into fdee/network/interfacesvith:

Interface name: usbO

ip address: 192.168.1.2

netmask: 255.255.255.0

gateway: 192.168.1.1 (commented with #)

At your computer console (not the robot console), execute the following for loadidgwéies
and setting the network connection:

sudo modprobe usbnet
sudo modprobe cdc_ether

sudo ifconfig usb0 192.168.1.3 netmask 255.255.255.0

You can transfer file with thecpcommand (see chapter 5.1.3). You can have remote access to
the KJ-EVO with chapter 5.1.5.

On Microsoft Windows, you may need to install a driver if the version is lower than Wsndow
(for Windows 7:http://developer.toradex.com/knowledge-base/how-to-install-microsoft-rndis-
driver-for-windows-7.

The driver is located here:

http://lwww.davehylands.com/linux/gumstix/usbnet/linux.inf

and the installation instructions there:
http://docwiki.gumstix.org/index.php/Windows XP usbnet

Then you configure the ip address 192.168.1.3 with netmask 255.255.255.0 and gateway
192.168.1.1 for your new network connection on the computer.
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5.1.5 Remote access
You can have remote access to the KJ-EVO board console while using Wifi or &/8B sl

1) Establish a connection between the KJ-EVO and the computer with oftee of
connections Wifi or USB slave method described in the chapters above.

2) In a console of the computer, launch the ssh command, where KJ-E\VADIDIRESS
is the network address of your KJ-EVO board:

ssh root@KJ-EVO_IP_ADDRESS
3) Accept thehost authenticitypy answering yes in pushing Return key.

=>root@kj-evo:~#appears; you are logged in.

5.1.6 Using the camera module

The driver of the camerant9v032.sdis loaded by default on start-up.

5.1.6.1 Taking images

With thev4l2grabprogram, you can take snapshots pictures with the camera:
v4l2grab —o image.jpg -W 752 —H 480 —q 85

where:
image.jpgis the output image file in JPEG format

752is the width of the image in pixel (max)
480is the height of the image in pixel (max)
85is the quality jpg compression in %

5.1.6.2 Video streaming

There is a mjpeg streamer with web server installed by default on the & b&afd.
Firstly, set a network connection as explained in chapters 5.1.2 or 5.1.4.

Then launch the mjpeg streamer with the following command on the KJ-EVO (in one line
command only:

mjpg_streamer -i "input_uvc.so —yuv —f 15" -0 "output_http.so -w /usr/locajpg-

streamer/www"

On a computer connected to the same network, you can have acdesssiied streaming at
http://KJ-EVO_1P:8080/?action=streamhereKJ-EVO _IPis the KJ-EVO network address.

You can stop with th€TRL-c keys.
You can configure the web server in the foldesr/local/mjpg-streamer/www Some help is
available in the fildusr/local/mjpg-streamer/www/README
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5.1.6.3 Programming Image processing
In the chapter 4.5.2;1 "Application development", you will find how to modify and compile
the examples source code. Select the following example for the camera:
~/kj-evo_development/kj-evo_library/examples/camera_example.c

Driver source code: you can access to the driver if you installed the full toolchain. The driver
bitbakerecipe is located in:

/usr/local/kjunior-oetools-1.0/user.collection/recipes/mt9v032-module

It is useful if you would like to change thetoexposurehdr, autogainorlow_light parameters.
You can test with the right combination of these parameters in untpate driver and
reloading it with these parameters in argument; example:

rmmod mt9v032
modprobe mt9v032 hdr=1

After compiling the module withitbake copy the file to the KJ-EVO and install it. You need to
remove the kernel module before:

opkg remove --force-depends kernel-module-mt9v032
opkg install mt9v032-module_1.0-r97.6_overo.ipk

5.1.6.4 Changing colors levels (whitebalance)

You need the full toolchain (chapter;4.6) to change the colors levels.

For testing, modify on your computer in file:
/usr/local/kjunior-oetools-1.0/tmp/work/overo-angstrom-linux-gnueahmlix-omap3-2.6.34-
ro97/git/drivers/media/videol/isp/isppreview.c

the structurespprev_rgbtorglcontaining the RGB blending, specially the paramd&&sGG
andBB with the matrix equation linking input to output colors:

static structispprev_rgbtorgtir_rgb2rgb
={
{ / RGB-RGB Matrix gains
RR, RG, RB }, _
{GR,GG, GB }' Rout RRf RGf RBf Rn ROff
{BR, BGBB} G |=| GR GG, GBy |IIG,, |+| Gof;
} /I RGB Offset B, BR, BG, BB, B, Bof,
{Rof, Gof, Bof}
3
C code Equation

KJ-EVO User Manual rev 1.0 41



5. Annexes

These parameters are integer values. They are coded in fixed-point numbe&f@189
gains and S10QO for the 3 offsets.

For converting the gains for the array, multiply by 256 and round the value. For ths, gdisie
round the value:

Example:
RR=0.8GG=1.0BB=1.5Rof=10.5
=>
RR =205 GG =256 BB =384 Rof =11

By default, all the parameters are zeros except RR= 256, @13l and BB = 498, which is for
an incandescent light source.

Then recompile the kernel:

- source theenv.shfile from your development folder
- install the needed programboot-mkimagewith : sudo apt-get install boot-mkimage
- go to folder

/usr/local/kjunior-oetools-1.0/tmp/work/overo-angstrom-linux-gnueabulix-omap3-
2.6.34-r97/qit/

- compile the kernel with the command
make clean
make -j8 ARCH=arm CROSS_ COMPILE=arm-angstrom-linux-gnueabi- ulmage

- in/usr/local/kjunior-oetools-1.0/tmp/work/overo-angstrom-linux-gnuedmiltx-omap3-
2.6.34-r97/git/arch/arm/bootiyou will have the kernel filaimage. Use this file for the
point 2) of chapter 4.6.3.3.

For future recompilations of the kernel and creations of the filesystem:

When you have found the right parameters, insert them in the existing patch file
/usr/local/kjunior-oetools-1.0/user.collection/recipes/linux/linsamap3-
2.6.34/overolisppreview.patch

and rebuild the kernel and filesystem as explained in chapter 4.6.3.1.

5.1.7 nfs configuration

The first service to set up should be transparent file sharingy WKS. Most Linux
distributions include NFS support by default, and the KJ-EVO systepady to be connected.
The directory to be shared between the computer and the board musidredd® the NFS
service in théetc/exportsconfiguration file. Please refer to NFS documentation, or mpares
for a detailed syntax description. Basically, the following Iste@uld be added to the file
/etc/exporton the computer:

/mnt/nfsarm KJ-EVO _[P/255.255.255.0(rw,no_root_squash,sync)

And make this folder on the computer:
mkdir /mnt/nfsarm
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The next step is to mount the shared directory to the KJ-EVO file system. Mounticeg a |
hard drive partition or a network directory is exactly the same from the usgopeiew, the
mount commands should be on the KJ-EVO, where COMPUTER_IP, is the IP address of the
computer which the KJ-EVO will be connected:

mkdir /mnt/nfs
mount -t nfs -0 nolock COMPUTER_IP:/mnt/nfsarm /mnt/nfs

If the NFS service is not started on the PC, the mount commdhdssue the following
message:

mount: RPC: Unable to receive; errno = Connection refused

NFS: mount program did not respond!

mount: nfsmount failed: Bad file descriptor

The NFS service is usually started using a startup sorptiiich location and name depend on
you distribution (for exampléetc/init.d/nfs).
Documentation for the distribution should detail the method to start and stop services.

Caution: For the nfs service to work properly, the portmap service shewdthrted as well and
if a firewall is active on the host machine, it should be condiguo allow the nfs port access
from the KJ-EVO.

Once the directory is successfully mounted, it can be actésse the board exactly as if it was

a local directory. Files on the PC can be read or written, nesvdan be created, and programs
can be executed, as long as they are ARM executables. If ekgihieeshared directory can be

unmounted using the command:

umount myMountPoint

5.1.8 Using microphones and speakers

Playing:

You must switch ON the speakers with the commands:

echo 64 >/sys/class/gpio/export
echo out >/sys/class/gpio/gpio64/direction
echo 1 >/sys/class/gpio/gpio64/value

You can play PCM WAV files witlaplay and the syntax:
aplay FILE.wav

and MPEG audio files witmadplayand the syntax:
madplay FILENAME —o cdda:- | aplay —f cdr
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You can then switch the speakers OFF with:

echo 0 >/sys/class/gpio/gpio64/value

Recording:
You can record PCM WAV witlarecordand the syntax:

arecord —f cd FILENAME.wav

The—f cd parameter sets the recording in stereo mode in CD quality. See with thermdmma
arecord —hfor all the parameters and help.
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Controlling volume:

You can modify the playback volume by launching the volume mixer with the command:

alsamixer

You change channel with the keyboard left and right arrows and volume with the up/down
arrows. The channels are for speakers of the KJU-EVO:

"Dac2 Analog" for standard control
"Dac?2 Digital Coarse" for rough control

"Dac?2 Fine Coarse"for fine control
You can change left and right with while a channel above is selected with:
Q and Z for left

W and X for both

E and C for right
And mute:
left with < key

right with > key
Pushingh will get you more help.

For modifying the record volume, push the Tab key whil@isamixer You change
channel with the keyboard left and right arrows and volume with the up/down arrows. The
channels are for the KJU-EVO:

"Analog Left Main Mic" for mute settings of left micro

"Analog Right Sub Mic" for mute settings of right micro

By default the record channels are muted. While a channel is selected, pushibgrspékce
toggle it.

You can change left and right while th&nalog' is selected with:
Q and Z for left

W and X for both

E and C for right

Programming playback and record:

In the chapter 4.5.2,1 "Application development", you will find how to modify and compile
the examples source code. Select the following example:

~/kj-evo_development/kj-evo_library/examples/sound_example.c
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5.1.9 Development with a virtual machine

You can install the development tools on a virtual machine if you don't have access to a
Linux machine. This is

You can even find a virtual machine image already configured with theogiewveht tools there:

http://ftp.k-team.com/K-JuniorVV2/extensions/kj-evo/virtual machine

» for the light tools (~2.1 GB): Ubuntu_LTS_KJ-EVO_light_tools.ova

o for the full tools (~15 GB): Ubuntu_LTS_KJ-EVO_full_tools.ova (available on
request)

1) Download and install VirtualBox, version 4.1.18 or newer for your computer from:
https://www.virtualbox.org/wiki/Downloads

If you choose a more recent version, you will have to reinstalbtiest Additions; see
VirtualBox user's manual.

2) Import on of the image file above with "File" menu, "Import Appta" in the
VirtualBox Manager.

This will take some time and hard disk space (~10 GB for ¢ tools and ~40 GB
for the full tools).

3) Create the directorg:\virtual_machine_sharedon your computer. This will be the
shared directory for transferring data between the virtualhmacand your host
computer. It corresponds to the directdmnyedia/sf_virtual_machine_shareaf the
virtual machine.

4) Start the virtual machine with your imported image:

Its login is:
username: user
password: root2011

5) The development tools are already installed. The development fdiger
evo_developmens in/home/user/kj-evo_development

6) You may need to update the toolchain. Remove the older one and followtingsuo
chapter 4.5:1 or 4.6.2 depending if this is the light or full toolchain.
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Stopping the virtual machine:

When going to the menu "Machine" and "Close, you will have 3 choices:

"Save the machine state": saves the current state, which will be etloextetime you
restart it.

- "Send the shutdown signal”, or press the shutdown button into the machine:
power off the machine and save only the work done.

- "Power off the machine": WARNING: it doesn't save anything; any work dahbev
discarded!

Serial port sharing:

You may configure your virtual machine to share the serial port to connect to-teédJfor
using Bluetooth ...).

- Power off your virtual machine.

- Select your machine image and press "Settings" button.

- Go to "Serial Ports" settings;

- On the tab "Port 1", enable the checkbox "Enable Serial Port" and choose:
Port Number: COML1 ( => this will be the Linux serial port /dev/ttySO0)
Port Mode:  Host Device

Port/File Path: COML1 if you have a standard serial port and using COM1.
Or change to adapt to your computer serial port or Bluetooth
emulated serial port.

5.1.10 Debugging

You can debug a program you made directly in console on the KJ-EVO or remotely.IllY¥ou wi
find on the DVD or online the needed files:

http://ftp.k-team.com/K-JuniorV2/extensions/KJ-EVO/software/debugger

5.1.10.1 Debugging on the KJ-EVO
* You need firstly to install the following packages with the comnapid) install
PACKAGE.IPK
libthread-dbl_2.9-r37.4.6_armv7a.ipk
gdb_7.1-r8.4.6_armv7a.ipk

* Then your program must be cross-compiled with the optipnEdit your Makefile and
replace the flagO2 by-g .

» Copy to the KJ-EVO the compiled program and its source file. And run for debugging it:
gdb YOUR_PROGRAM
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The basic commands are:

r . run

n . next: one step in the program; enter in subroutines
S . one step in the program

b line/function : break at line/function

deletebreak . delete breakpoint number

until line . continue until line

c . continue

I . list code

q : quit gdb

h . help; you can have all the commands here

A common sequence of debugging can be:
* to list the code witlh
* set a breakpoint at the beginning of main viatmain
* run the program with
e execute a step with
» display a variable witp VAR_NAME
* execute next step witin
» continue to the end witt
e Quit withq.

5.1.10.2 Remote debugging

You need firstly to install the following package with the commapkl install
PACKAGE.IPK

gdbserver_7.1-r8.0.6_armv7a.ipk

» Then run the gdbserver with your cross-compiled program and an unused port number as
argument (her&234)

gdbserver --multi :1234 YOUR_PROGRAM
* Source your env.sh (see chapter 4.5.2.1) and run:
source ~/kj-evo_development/env.sh

* Go to the folder where you cross-compiled your program
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* You can use the debugger in command line or datthGUI:

Command line:

» Execute for running the debugger on the computer:
arm-angstrom-linux-gnueabi-gdb YOUR_PROGRAM
* Inthis debugger, set parameter and connect to the remote gdb with these 2 commands:
set sysroot /usr/local/kjunior-oetools-1.0/tmp/sysroots/armv7a-angstioonxignueabi
target extended-remote YOUR_KJU_IP_ADDRESS:1234

With GUI:
* On your computer, install ddd the debugger GUI with :
sudo apt-get install ddd
* Launch ddd with:
ddd --debugger arm-angstrom-linux-gnueabi-gdb YOUR_PROGRAM
* In the window at the bottom where the (gdb) prompt is, run these 2 commands:
set sysroot /usr/local/kjunior-oetools-1.0/tmp/sysroots/armv7a-angstiooxignueabi
target extended-remote YOUR_KJU_IP_ADDRESS:1234

The sequence of debugging and also the commands are the sameibsddabove in chapter
5.1.10.1.

You can even send your program to the remote (KJ_evo) with the gdb commands:

remote puthostfiletargetfile
set remote exec-file@argetfile

where hostfile and targetfile is the same name of your new program to be
debugged.

For quitting the debugger and remote, execute commanmistor exit, then disconnectand
finally quit .

Tips for using the advantage of the GUI:

o For setting a breakpoint, double-click on the line you want to put it, just before the
line number or right click at the same place or choose “Set Breakpoint”.

0o  With the floating menu, you have the different commands for debugging.

0 You can add a watch on a variable with clicking with the right mouse button on the
variable and choose “Display VARIABLE_NAME”.
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5.1.10.3 Remote debugging with Eclipse

You can also debug remotely your program with Eclipse (see chapter 4.5.2(#dpea
installation). Follow instructions below:

1)

2)

3)
4)

5)
6)

7)

8)
9)

Install gdbserveion your kj-evo as explained in chapter 5.1.10.2 above.

On Eclipse menu 'Run' => Debug Configurations' , double click'©h+ Remote
Application'

=> test Debug is created.
In the 'Main' tab => “C/C++ application”, enter: Debug/test

On “Connection”. push “New” button and choose “SSH”, in the next window,
Hostname ip address of your kj-evo and push “Finish” button.

On "Remote Absolute File Path for C/C++ Application” modifyhmme/root/test

In the Debugger tab, choose
'fusr/local/kjunior-oetools-1.0/tmp/sysroots/i686-linux/usr/armv7a/bindar
angstrom-linux-gnueabi-gdb
On 'Main® tab change 'GDB Debugger tolust/local/kjunior-oetools-
1.0/tmp/sysroots/i686-linux/usr/armv7a/bin/arm-angstrom-linux-gnueabi-gdb
On 'Shared Libraries' tab addisr/local/kjunior-oetools-1.0/tmp/sysroots/armv7a-
angstrom-linux-gnueabi/lib
Then Push Debug, enterot as "User ID" and no password.

Debug step by step.

You can go again into the settings, and select "Release" configuration whenogranphas
been fully debugged.

You can run the program from the kj-evo (with a remote terminal) or with Eclipse G
After having set the Debug configuration, the parameters are also avéolatble run.

Just go the menu Run, then choose “Run”.

In the lower part of the Eclipse window, you will see the output of your program in thel€ons
tab.
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6.

WARRANTY

K-TEAM warrants that the KJ-EVO is free from defects imatemials and
workmanship and in conformity with the respective specificationth@fproduct for the
minimal legal duration, respectively one year from the date of delivery.

Upon discovery of a defect in materials, workmanship or failure &etnthe
specifications in the Product during the afore mentioned period, Custaostrrequest

the type of KJ-EVO used (version)
the kernel version of the KJ-EVO

the programming environment of the KJ-EVO/robot (standard, version, OS)

the standard use of Product before the appearance of the problem

the description of the problem.

If no answers have been received within two working days, Custa@anerantact K-
TEAM support by phone or by electronic mail with the full refeesof its order and KJ-
EVO serial number.

K-TEAM shall then, at K-TEAM's sole discretion, either repsirch Product or
replace it with the equivalent product without charging any techlabar fee and repair
parts cost to Customer, on the condition that Customer brings such Prod+d EAM
within the period mentioned before. In case of repair or replacelerEAM may own
all the parts removed from the defective Product. K-TEAM may mee and/or
reconditioned parts made by various manufacturers in performinguwyarrepairs and
replacement of the Product. Even if K-TEAM repairs or replélsesProduct, its original
warranty term is not extended.

This limited warranty is invalid if the factory-applied sémnamber has been altered
or removed from the Product.
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This limited warranty covers only the hardware and softwameponents contained
in the Product. It does not cover technical assistance for hardwaaddtware usage and it
does not cover any software products contained in the Product. KAT&&ludes all
warranties expressed or implied in respect of any additiooflvare provided with
Product and any such software is provided "AS IS" unless expnesslided for in any
enclosed software limited warranty. Please refer to the Emat Usense Agreements
included with the Product for your rights with regard to the licemsasupplier of the
software parts of the Product and the parties' respective obhigatith respect to the
software.

This limited warranty is non-transferable.

It is likely that the contents of Customer's flash memoti/lvei lost or reformatted in
the course of the service and K-TEAM will not be responsible fprdamage to or loss of
any programs, data or other information stored on any mediayopat of the Product
serviced hereunder or damage or loss arising from the Produieingt available for use
before, during or after the period of service provided or any icide consequential
damages resulting therefore.

IF DURING THE REPAIR OF THE PRODUCT THE CONTENTS OF THE FLASH
MEMORY ARE ALTERED, DELETED, OR IN ANY WAY MODIFIED, KTEAM IS
NOT RESPONSIBLE WHATEVER. CUSTOMER'S PRODUCT WILL BEETURNED
TO CUSTOMER CONFIGURED AS ORIGINALLY PURCHASED (SUBCT TO
AVAILABILITY OF SOFTWARE).

Be sure to remove all third parties' hardware, softwareurest parts, options,
alterations, and attachments not warranted by K-TEAM prior to Preeunzice. K-TEAM
is not responsible for any loss or damage to these items.

This warranty is limited as set out herein and does not covgrc@asumable items
(such as batteries) supplied with the Product; any accessodugbs which is not
contained in the Product; cosmetic damages; damage or loss to amgregsrograms,
data, or removable storage media; or damage due to (1) acts ofh€auknt, misuse,
abuse, negligence, commercial use or modifications of the Produatngroper operation
or maintenance of the Product; (3) connection to improper voltage supfdy; aitempted
repair by any party other than a K-TEAM authorized module service yacilit

This limited warranty does not apply when the malfunction resualts the use of the
Product in conjunction with any accessories, products or ancillggrgeheral equipment,
or where it is determined by K-Team that there is no fault with the Prodeitt its
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K-TEAM EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES THAN
STATED HEREINBEFORE, EXPRESSED OR IMPLIED, INCLUDIN®/ITHOUT
LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY AN D FITNESS
FOR A PARTICULAR PURPOSE TO THE FULLEST EXTENT PERMED BY
LAW.

Limitation of Liability: IN NO EVENT SHALL EITHER PARTYBE LIABLE TO
THE OTHER FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CRSEQUENTIAL
DAMAGES RESULTING FROM PERFORMANCE OR FAILURE TO REORM
UNDER THE CONTRACT, OR FROM THE FURNISHING, PERFORMAK OR USE
OF ANY GOODS OR SERVICE SOLD OR PROVIDED PURSUANTERETO,
WHETHER DUE TO A BREACH OF CONTRACT, BREACH OF WARRHY,
NEGLIGENCE, OR OTHERWISE. SAVE THAT NOTHING HEREIN ${iL LIMIT
EITHER PARTY'S LIABILITY FOR DEATH OR PERSONAL INJBY ARISING
FROM ITS NEGLIGENCE, NEITHER PARTY SHALL HAVE ANY LABILITY TO
THE OTHER FOR INDIRECT OR PUNITIVE DAMAGES OR FORNY CLAIM BY
ANY THIRD PARTY EXCEPT AS EXPRESSLY PROVIDED HEREIN
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